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TÓM TẮT  

Trong bối cảnh chuyển đổi số y tế và nhu cầu chăm sóc sức khỏe cá nhân hóa 
gia tăng, nghiên cứu này phát triển hệ thống bác sĩ AI hỗ trợ dinh dưỡng theo mô 
hình EatClean. Hệ thống gồm: thiết bị đeo thu thập dữ liệu thể trạng thời gian 
thực; mô hình AI (KNN, Random Forest, CNN, LSTM, hybrid recommender, 
Reinforcement Learning) phân tích dữ liệu, nhận diện món ăn, dự báo nhu cầu 
năng lượng và đề xuất thực đơn cá nhân hóa; nền tảng tư vấn trực tuyến kết nối 
chuyên gia dinh dưỡng. Ứng dụng triển khai trên web và di động, giúp người 
dùng quản lý chế độ ăn linh hoạt, hiệu quả. Đánh giá ban đầu cho thấy hệ thống 
cải thiện sự hài lòng, hỗ trợ điều chỉnh lối sống và có tiềm năng ứng dụng trong 
chăm sóc dinh dưỡng cộng đồng, bệnh viện thông minh tại Việt Nam. 

Từ khóa: Eatclean, hệ thống dinh dưỡng chuyên sâu, bác sỹ AI. 

ABSTRACT  

In the context of digital transformation in healthcare and the growing 
demand for personalized healthcare, this study develops an AI-powered doctor 
system based on the EatClean model to support nutrition. The system includes: 
wearable devices that collect real-time physiological data; AI models (KNN, 
Random Forest, CNN, LSTM, hybrid recommender systems, and Reinforcement 
Learning) that analyze data, recognize food items, predict energy needs, and 
propose personalized meal plans; and an online consultation platform that 
connects users with nutrition experts. The application is deployed on both web 
and mobile platforms, enabling users to manage their diets flexibly and 
effectively. Initial evaluations indicate that the system improves user 
satisfaction, supports lifestyle adjustments, and shows strong potential for 
application in community nutrition care and smart hospitals in Vietnam. 

Keywords: Eatclean, intensive nutrition system, AI doctor. 
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1. GIỚI THIỆU 
Trong những thập kỷ gần đây, chăm sóc sức khỏe 

không còn chỉ tập trung vào điều trị bệnh lý mà đã mở 
rộng sang hướng tiếp cận dự phòng, trong đó dinh 
dưỡng đóng vai trò trung tâm [1, 2]. Các nghiên cứu đã 
chứng minh rằng chế độ ăn uống hợp lý như chế độ Địa 
Trung Hải [2] hay chế độ ăn ít carbohydrate [3] có khả 
năng cải thiện sức khỏe tổng thể, kiểm soát cân nặng và 
làm giảm nguy cơ mắc các bệnh mạn tính như tim mạch, 
tiểu đường và béo phì, đặc biệt ở nhóm người cao tuổi [4]. 
Đồng thời, sự phát triển của lĩnh vực "dinh dưỡng cá nhân 
hóa" (personalized nutrition) với sự hỗ trợ từ phân tích 
chuyển hóa (metabolomics) đang ngày càng khẳng định 
tầm quan trọng của can thiệp dinh dưỡng dựa trên đặc 
điểm sinh học riêng biệt [5]. 

Sự bùng nổ của trí tuệ nhân tạo (AI), công nghệ đeo 
thông minh và dữ liệu lớn (Big Data) đang tạo ra một bước 
ngoặt trong mô hình “chăm sóc sức khỏe cá nhân hóa” [6, 
8]. Các thuật toán học máy có khả năng phân tích khối 
lượng dữ liệu khổng lồ từ cảm biến sinh học, thiết bị di 
động, hồ sơ sức khỏe điện tử và dữ liệu gen để dự đoán 
nhu cầu dinh dưỡng, phát hiện xu hướng bất thường trong 
hành vi ăn uống và từ đó đưa ra khuyến nghị phù hợp [8, 
10, 13, 21]. Các thiết bị đeo thông minh, bao gồm cảm biến 
nhịp tim, đo nồng độ glucose, cảm biến chuyển động và 
thiết bị theo dõi giấc ngủ, đã được cải tiến đáng kể về độ 
chính xác và tính liên tục trong theo dõi [7, 9, 26, 27]. 

Mô hình tương tác người - máy (human-in-the-loop) 
đang nổi lên như một chiến lược hiệu quả nhằm kết hợp 
lợi thế của trí tuệ nhân tạo và chuyên môn của con người. 
Trong đó, hệ thống AI đảm nhiệm vai trò phân tích và đề 
xuất khẩu phần cá nhân hóa, trong khi chuyên viên dinh 
dưỡng kiểm chứng và điều chỉnh khuyến nghị dựa trên 
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yếu tố dị ứng, bệnh nền, thói quen và văn hóa của từng 
cá nhân [12, 13, 17, 18, 29]. Điều này đặc biệt quan trọng 
trong bối cảnh chăm sóc dinh dưỡng lâm sàng - nơi mà 
tính chính xác, độ tin cậy và tính thích ứng là những yêu 
cầu tiên quyết. 

Tuy nhiên, hiện nay phần lớn các hệ thống hỗ trợ dinh 
dưỡng còn tồn tại nhiều hạn chế, như khả năng phản hồi 
theo thời gian thực, mức độ cá nhân hóa sâu, khả năng 
tích hợp thiết bị và kết nối liên ngành [13, 20, 31]. Các nền 
tảng hiện có như hệ thống đề xuất thực đơn bằng học sâu 
[15], ứng dụng theo dõi bệnh nhân ung thư sau điều trị 
[16] và hệ thống tư vấn chế độ ăn kiêng tự động [14] đã 
mang lại những kết quả ban đầu nhưng vẫn chưa đạt 
được mức độ triển khai rộng rãi trong cộng đồng. 

Do đó, nghiên cứu này đề xuất một mô hình tích hợp 
gồm ba thành phần chính: (1) thiết bị đeo theo dõi dinh 
dưỡng chuyên sâu tích hợp cảm biến sinh học; (2) hệ 
thống bác sĩ AI sử dụng mạng nơ-ron sâu để phân tích dữ 
liệu sinh học và hành vi ăn uống nhằm đưa ra khẩu phần 
tối ưu; và (3) nền tảng tư vấn trực tuyến phối hợp cùng 
chuyên viên dinh dưỡng nhằm hỗ trợ người dùng mọi lúc, 
mọi nơi. Mô hình hướng tới mục tiêu hiện thực hóa "Chăm 
sóc dinh dưỡng 4.0", nơi người dùng có thể chủ động 
kiểm soát chế độ ăn uống, nhận được tư vấn y tế chính 
xác và cá nhân hóa theo thời gian thực [19, 22, 25]. 

Thông qua việc xây dựng, triển khai và đánh giá hệ 
thống, nghiên cứu không chỉ cung cấp bằng chứng về 
hiệu quả ứng dụng AI trong chăm sóc dinh dưỡng, mà 
còn góp phần hình thành nền tảng cho các hệ thống y tế 
thông minh - phù hợp với mục tiêu chuyển đổi số y tế 
quốc gia trong kỷ nguyên hậu COVID-19 [6, 20, 28]. 

2. THIẾT KẾ HỆ THỐNG DINH DƯỠNG CHUYÊN SÂU 
EATCLEAN KẾT HỢP TRÍ TUỆ NHÂN TẠO 

2.1. Cơ sở lý thuyết 
2.1.1. Dinh dưỡng cá nhân hóa và vai trò trong chăm 

sóc sức khỏe 
Dinh dưỡng cá nhân hóa (Personalized Nutrition) là xu 

hướng nổi bật trong y học hiện đại, nhằm xây dựng chế 
độ ăn tối ưu theo đặc điểm sinh học, sức khỏe và hành vi 
lối sống từng cá nhân [17]. Khác với khuyến nghị dinh 
dưỡng đại trà, mô hình này điều chỉnh khẩu phần dựa 
trên dữ liệu thời gian thực như BMI, BMR, bệnh lý nền, yếu 
tố di truyền, hoạt động thể chất và tâm lý xã hội [18]. 
Nhiều nghiên cứu cho thấy dinh dưỡng cá nhân hóa 
không chỉ cải thiện hiệu quả điều trị các bệnh mãn tính 
như tiểu đường, tim mạch, ung thư mà còn hỗ trợ phòng 
ngừa sớm rối loạn chuyển hóa và giảm chi phí y tế cộng 
đồng [19, 20]. 

2.1.2. Trí tuệ nhân tạo trong hỗ trợ ra quyết định 
dinh dưỡng 

Trí tuệ nhân tạo (AI) trong y tế đang đạt nhiều tiến bộ, 
đặc biệt trong phân tích dữ liệu sức khỏe phức tạp và hỗ 
trợ quyết định lâm sàng. Các mô hình học máy (ML) và 
học sâu (DL) khai thác dữ liệu lớn từ hồ sơ bệnh án, chỉ số 
sinh học, hành vi ăn uống để xây dựng hệ thống dự đoán 
và khuyến nghị dinh dưỡng [21]. ML truyền thống (SVM, 
Random Forest, KNN) được dùng phân loại thể trạng và 
phân nhóm người dùng theo mục tiêu dinh dưỡng (tăng 
cơ, giảm cân, điều trị bệnh…) [22]. Mạng nơ-ron tích chập 
(CNN) hỗ trợ nhận diện món ăn, phân tích thành phần 
dinh dưỡng từ hình ảnh [23]. Mạng hồi tiếp (RNN, LSTM) 
dự đoán nhu cầu năng lượng theo chuỗi hành vi vận 
động và tiêu dùng, điều chỉnh thực đơn thời gian thực 
[24]. Học tăng cường (Reinforcement Learning) tối ưu 
khẩu phần ăn dài hạn qua phản hồi người dùng, hướng 
đến cải thiện sức khỏe bền vững [25]. Các hệ thống AI 
không chỉ dựa trên dữ liệu định lượng mà còn học và 
thích nghi với sở thích, hành vi, điều kiện văn hóa - xã hội 
- kinh tế cá nhân, từ đó nâng cao mức độ cá nhân hóa 
trong chăm sóc dinh dưỡng. 

2.1.3. Hệ thống cảm biến sinh học và đo lường trong 
dinh dưỡng 

Các cảm biến sinh học (biomedical sensors) giữ vai trò 
then chốt trong hệ thống chăm sóc dinh dưỡng thời gian 
thực. Cảm biến lực (Loadcell) đo khối lượng cơ thể, tính 
toán BMI và theo dõi thay đổi trọng lượng [26]. Cảm biến 
nhịp tim PPG (Photoplethysmography) đánh giá tuần 
hoàn và mức độ vận động, hỗ trợ điều chỉnh thực đơn 
phù hợp [27]. Thiết bị đeo (wearables) ghi nhận lượng 
calo tiêu hao, chất lượng giấc ngủ, mức vận động và đồng 
bộ với hồ sơ sức khỏe cá nhân [28]. Sự kết hợp giữa cảm 
biến sinh học và AI tạo nên hệ thống theo dõi dinh dưỡng 
liên tục, không xâm lấn và hiệu quả. 

2.1.4. Mô hình bác sĩ ảo và hệ thống chuyên viên trực 
tuyến 

Trong hệ thống chăm sóc sức khỏe thông minh, mô 
hình bác sĩ ảo (AI-doctor) kết hợp chuyên viên tư vấn trực 
tuyến đang trở thành xu hướng chủ đạo. AI đảm nhiệm 
thu thập, xử lý dữ liệu và đề xuất giải pháp, còn con người 
đóng vai trò điều phối, hiệu chỉnh và tương tác tự nhiên 
[29]. Mô hình human-in-the-loop này được chứng minh 
hiệu quả với các ứng dụng yêu cầu độ chính xác và mức 
độ tương tác cao [30]. Bên cạnh đó, nền tảng web và ứng 
dụng di động giúp chuyên viên theo dõi dữ liệu sức khỏe 
từ xa, tư vấn trực tuyến và đồng hành liên tục cùng bệnh 
nhân trong quá trình điều chỉnh lối sống. 
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2.1.5. Tích hợp hệ thống IoT - AI - Mobile Health 
Sự hội tụ của Internet of Things (IoT), trí tuệ nhân tạo 

và ứng dụng y tế di động (mHealth) tạo ra một hệ sinh 
thái chăm sóc sức khỏe thông minh, trong đó dinh dưỡng 
là một trụ cột quan trọng [31]. Các thành phần kết nối qua 
mạng không dây, API mở, hệ thống dữ liệu phi tập trung 
(cloud + local) và công cụ phân tích thời gian thực giúp 
đảm bảo tính liên tục, chính xác và hiệu quả trong tư vấn 
dinh dưỡng. 

2.2. Thiết kế phần cứng hệ thống  
Hệ thống chăm sóc dinh dưỡng thông minh được 

thiết kế như một nền tảng tích hợp đa lớp gồm: tầng thu 
thập dữ liệu cảm biến, tầng xử lý trí tuệ nhân tạo (AI 
layer), và tầng giao tiếp người dùng (UI/UX layer). Các 
tầng này được kết nối bằng kiến trúc client-server với cơ 
chế trao đổi dữ liệu thời gian thực (real-time 
synchronization) qua API RESTful. Hình 1 là mô tả chi tiết 
từng lớp công nghệ. 

 
Hình 1. Sơ đồ cấu trúc hệ thống 

2.2.1. Phần cứng đo lường sinh học (Biomedical IoT 
Layer) 

Hệ thống phần cứng được xây dựng nhằm thu thập 
các chỉ số sinh học phục vụ cho phân tích dinh dưỡng. 
Cấu trúc bao gồm: 

Load Cell 50kg + Module HX711: Cảm biến lực 
Loadcell được mắc theo cấu trúc cầu Wheatstone để đo 
khối lượng cơ thể chính xác. Module HX711 thực hiện 
khuếch đại tín hiệu và chuyển đổi ADC 24-bit, đảm bảo 
độ phân giải cao khi truyền dữ liệu về ESP32 (hình 2). 

 
(a) 

 
(b) 

Hình 2. Cảm biến cân nặng (a) và sơ đồ đấu nối mạch cân (b) 

Cảm biến PPG (HW-827): Dùng phương pháp quang 
học đo nhịp tim dựa trên phản xạ ánh sáng từ mạch máu, 
cho phép đánh giá tình trạng tim mạch và mức độ vận 
động (hình 3). 

 
(a) 

 
(b) 

Hình 3. Cảm biến đo nhịp tim (a) và Sơ đồ đấu nối mạch đo nhịp tim 

Vi điều khiển ESP32: Là bộ xử lý trung tâm, sử dụng 
lõi xử lý Xtensa LX6 dual-core, tốc độ lên đến 240MHz, hỗ 
trợ Wi-Fi + Bluetooth. ESP32 thu nhận dữ liệu cảm biến, 
xử lý sơ bộ, mã hóa và truyền đến máy chủ qua HTTP hoặc 
MQTT (hình 4). 

 
Hình 4. Vi điều khiển ESP32 

Ngoài ra hệ thống còn có Màn hình LCD 1602 I2C để 
hiển thị dữ liệu BMI, BMR, nhịp tim từ đó người dùng theo 
dõi tại chỗ, với giao tiếp I2C giúp tiết kiệm chân giao tiếp 
và năng lượng. Pin 18650 Li-ion để cấp nguồn di động 
cho toàn bộ hệ thống, đảm bảo hoạt động liên tục ít nhất 
24 giờ với một lần sạc. 
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(a) 
 

(b) 

Hình 5. Màn hình LCD 1602 I2C (a), và Pin 18650 Li-ion (b)  

2.2.2. Hệ thống trí tuệ nhân tạo (AI Engine Layer) 

Cấu trúc trí tuệ nhân tạo của hệ thống được phân làm 
3 phần: 

Phần thứ nhất là trung tâm xử lý trí tuệ nhân tạo (AI 
Engine), nó đóng vai trò trung tâm trong hệ thống chăm 
sóc dinh dưỡng thông minh, thực hiện phân tích chỉ số 
sinh học, phân loại thể trạng, đề xuất thực đơn cá nhân 
hóa, dự báo nhu cầu năng lượng và điều chỉnh chế độ ăn 
theo hành vi thực tế. Hai thuật toán học máy được sử 
dụng: K-Nearest Neighbors (KNN), phân loại thể trạng 
dựa trên khoảng cách Euclidean giữa đặc trưng người 
dùng và dữ liệu huấn luyện; và Random Forest (RF), kết 
hợp nhiều cây quyết định nhằm tăng độ chính xác, giảm 
overfitting và xử lý dữ liệu phi tuyến [34, 35]. Dữ liệu đầu 
vào gồm: 

- Chỉ số sinh học: BMI, BMR, tỷ lệ mỡ cơ thể, lượng 
nước, chiều cao, cân nặng. 

- Nhân khẩu học: tuổi, giới tính. 

- Hành vi dinh dưỡng: tần suất ăn sáng, lượng nước 
uống/ngày, thói quen ăn vặt. 

Từ đó đầu ra sẽ được gán nhãn:  

Nhãn phân loại: ['Underweight', 'Normal', 
'Overweight', 'Obese', 'Athlete', 'Chronic Patient']. 

Với chỉ số BMI được tính theo công thức (1) sau [32]:  

2

m
BMI

l
                                                                                   (1) 

Trong đó: m là cân nặng (kg); l là chiều cao (m) 

Phần thứ hai là học sâu (Deep Learning - DL): Thuật 
toán học sâu dùng để nhận diện món ăn từ hình ảnh (nếu 
hệ thống tích hợp camera), ước lượng thành phần dinh 
dưỡng (carb, protein, fat, calories), dự đoán nhu cầu calo 
và năng lượng tiêu hao cá nhân theo chuỗi thời gian. Học 
sâu ta sử dụng 2 thuật toán: CNN (Convolutional Neural 
Network) để xử lý ảnh món ăn → trích xuất đặc trưng thị 
giác → phân loại tên món ăn và định lượng dinh dưỡng 

và RNN / LSTM (Long Short-Term Memory) để dự đoán 
nhu cầu calo cá nhân theo lịch sử ăn uống - vận động 
trong chuỗi thời gian. 

Các đặc trưng đầu vào của thuật toán: 

+) Hình ảnh món ăn (từ camera tích hợp hoặc tải lên 
app). 

+) Chuỗi dữ liệu dinh dưỡng hàng ngày: [lượng calo tiêu 
thụ], [lượng vận động], [trạng thái thể chất]. 

Đầu ra sẽ là: 

+) Tên món ăn, khối lượng ước lượng, thành phần dinh 
dưỡng (gram + kcal). 

+) Dự đoán calo cần thiết cho ngày tiếp theo. 

Mô hình kiến trúc CNN:  

Input Image → Convolution Layer → ReLU → 
MaxPooling → FC Layer → Softmax 

Hệ thống gợi ý khẩu phần ăn (Recommendation 
System): Đề xuất thực đơn cá nhân hóa phù hợp với thể 
trạng, bệnh nền, sở thích ăn uống và hành vi tiêu dùng 
thực phẩm. Hệ thống gợi ý kết hợp (Hybrid 
Recommendation System) gồm: Collaborative Filtering 
sử dụng trong Khai thác dữ liệu người dùng tương tự để 
gợi ý món ăn (sở thích cộng đồng) và Content-Based 
Filtering dùng phân tích đặc trưng dinh dưỡng món ăn 
(chất béo, calo, thành phần...) để gợi ý theo nhu cầu cá 
nhân. Hệ thống sử dụng dữ liệu đầu vào gồm: lịch sử lựa 
chọn thực đơn, hồ sơ sức khỏe (thể trạng, giới tính, nhu 
cầu calo), và đánh giá món ăn (rating hoặc từ chối). Dựa 
trên đó, AI tạo danh sách món ăn gợi ý cho từng bữa 
(sáng, trưa, tối) và xây dựng thực đơn cá nhân hóa cho 7 
ngày. Ví dụ: Nếu người dùng từng chọn “cơm gạo lứt, cá 
hấp, rau luộc”, hệ thống sẽ gợi ý “súp yến mạch, thịt ức gà 
hấp” thay vì món nhiều dầu/mỡ [36, 37]. 

Phần thứ ba là học tăng cường (Reinforcement 
Learning - RL) sử dụng trong tối ưu hóa kế hoạch dinh 
dưỡng lâu dài thông qua cơ chế phản hồi (feedback loop) 
từ người dùng và chuyên viên dinh dưỡng. Mô hình học 
bao gồm: Agent là AI đề xuất thực đơn và chế độ ăn uống, 
Environment là người dùng, trạng thái sức khỏe thay đổi, 
và Reward là mức độ hài lòng, chỉ số sức khỏe cải thiện, 
phản hồi chuyên viên [38]. 

Kỹ thuật học sử dụng Q-Learning / DQN (Deep Q-
Network) trong lập bảng phần thưởng và dần học chính 
sách ăn uống tối ưu qua chuỗi thời gian với Reward 
Function được tính theo công thức (2) sau [33]: 

t health user _ satisfaction expert _ feedbackR α S β S γ C            (2) 
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Trong đó: ΔShealth là mức cải thiện thể trạng, 
Suser_satisfaction là mức độ hài lòng người dùng, Cexpert_feedback 

là ghi nhận điều chỉnh từ chuyên viên. 

Từ đó AI không chỉ đề xuất tốt ở thời điểm hiện tại mà 
còn thích nghi theo thời gian và cá nhân hóa sâu hơn cho 
từng hành vi và lối sống. 

Bảng 1.Vai trò các thuật toán AI trong hệ thống 

Thành phần AI Thuật toán sử dụng Chức năng chính 

Phân loại thể trạng KNN, Random Forest Phân nhóm người dùng 

Nhận diện món ăn CNN 
Xử lý ảnh, trích xuất 
thông tin dinh dưỡng 

Dự đoán nhu cầu 
năng lượng 

LSTM Dự báo theo chuỗi 

Gợi ý thực đơn Hybrid Recommender Khẩu phần cá nhân hóa 

Tối ưu hóa kế hoạch 
ăn uống 

RL (Q-Learning, DQN) 
Tự học và cải tiến thực 
đơn 

2.2.3 Nguyên lý hoạt động của hệ thống 

Hệ thống chăm sóc dinh dưỡng thông minh vận hành 
theo một chu trình khép kín, liên tục và phản hồi động, 
đảm bảo tính cá nhân hóa - thích nghi - thời gian thực. 
Quy trình được tổ chức thành năm giai đoạn chính, mỗi 
giai đoạn đảm nhận một nhiệm vụ cụ thể trong chuỗi 
chăm sóc dinh dưỡng, sơ đồ cấu trúc hoạt động hệ thống 
như hình 6. 

Máy tính lưu 
trữ dữ liệu

Thiết bị 
cảm biến

ESP32

AI phân tích 
thể trạng

Gợi ý thực đơn theo 
phân tích

Phản hồi người dùng
 

Hình 6. Sơ đồ cấu trúc hoạt động hệ thống 

Giai đoạn 1: Thu thập và xử lý dữ liệu đầu vào (Data 
Acquisition & Preprocessing) 

Người dùng tương tác với thiết bị phần cứng để đo và 
cập nhật các chỉ số sinh học. Các dữ liệu được thu thập 
bao gồm: 

- Dữ liệu sinh học: cân nặng, chỉ số BMI, nhịp tim, tỷ lệ 
mỡ cơ thể, lượng nước, chu vi vòng bụng (hình 7). 

- Thông tin cá nhân: độ tuổi, giới tính, mức độ vận 
động, bệnh lý nền. 

- Hành vi ăn uống: thông qua ứng dụng mobile/web, 
người dùng nhập dữ liệu món ăn, thời gian ăn, khẩu phần, 
mức độ hài lòng... 

 

 
Hình 7. Hình ảnh cân sinh học và thiết bị đo nhịp tim khi thực hiện lấy 

thông số 

Tín hiệu từ cảm biến (cân nặng, nhịp tim) được đọc bởi 
ESP32, xử lý sơ bộ (lọc nhiễu, chuyển đổi tín hiệu), và sau 
đó được mã hóa theo định dạng JSON để gửi qua Wi-Fi 
đến máy chủ backend. Dữ liệu đầu vào được lưu trữ trong 
cơ sở dữ liệu SQL để phục vụ các giai đoạn xử lý tiếp theo 
(hình 8). 

 
Hình 8. Hình ảnh xây dựng cơ sở dữ liệu lưu trữ cho trang web 

Giai đoạn 2: Phân tích thể trạng và phân loại người 
dùng (User Profiling & Classification) 

AI nhận dữ liệu sinh học đã tiền xử lý và sử dụng các 
mô hình học máy (KNN, Random Forest) để phân loại 
người dùng vào một trong các nhóm thể trạng: Gầy 
(Underweight), bình thường (Normal), thừa cân 
(Overweight), béo phì (Obese), vận động viên (Athlete), 
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người có bệnh nền (Chronic patient). Mỗi nhóm sẽ được 
gán với bộ quy tắc đề xuất dinh dưỡng riêng, bao gồm 
mức calo tiêu chuẩn/ngày, tỉ lệ chất dinh dưỡng 
(carbohydrate, protein, fat), khuyến nghị món ăn và hạn 
chế thực phẩm (hình 9). 

 
Hình 9. Hình ảnh hiển thị, tính toán, đề xuất lượng kcal/ngày 
Ví dụ: Nhóm "béo phì" có thực đơn ưu tiên thực phẩm 

giàu chất xơ, ít tinh bột nhanh, nhiều nước; nhóm "vận 
động viên" được khuyến nghị tăng protein và calo. 

Giai đoạn 3: Gợi ý thực đơn cá nhân hóa (Personalized 
Diet Recommendation) 

Dựa trên hồ sơ người dùng, AI triển khai hệ thống 
khuyến nghị thực đơn theo hai hướng:  

- Thứ nhất, ngắn hạn (bữa ăn hiện tại / trong ngày): 
dựa trên trạng thái sinh học tức thời và hành vi gần nhất. 

- Thứ hai, dài hạn (kế hoạch 7 ngày - 30 ngày): dựa trên 
lịch sử sức khỏe, mục tiêu sức khỏe (giảm cân, tăng cơ, 
kiểm soát đường huyết...). 

Công cụ đề xuất sử dụng Hybrid Recommender 
System, kết hợp:  

- Content-based filtering: dựa vào thành phần dinh 
dưỡng của món ăn 

- Collaborative filtering: học từ dữ liệu và phản hồi 
của người dùng có hồ sơ tương đồng. 

Đầu ra là một danh sách món ăn và thực đơn gợi ý, có 
thể tùy chỉnh lựa chọn theo khẩu vị, văn hóa vùng miền, 
hoặc chi phí với hơn 700 món ăn khác nhau (hình 10). 

 
Hình 10. Hình ảnh gợi ý thực đơn và chỉ số calol của món ăn 

Giai đoạn 4: Tư vấn và phản hồi qua hệ thống chuyên 
viên (Human-in-the-loop Feedback) 

Sau khi nhận được gợi ý từ hệ thống AI, người dùng có 
thể: Trao đổi với chuyên viên dinh dưỡng qua nền tảng 
web/mobile (chat, gọi video, tin nhắn) và có thể gửi phản 
hồi về khẩu phần, cảm nhận, tình trạng cơ thể sau bữa ăn. 
Các chuyên viên có quyền điều chỉnh khẩu phần ăn, giải 
thích logic đề xuất của AI và đưa ra lời khuyên sâu hơn 
dựa trên kinh nghiệm lâm sàng, bệnh lý cá nhân hoặc yếu 
tố văn hóa. Phản hồi từ người dùng và chuyên viên được 
lưu trữ để cải thiện mô hình AI trong tương lai. 

Người dùng có thể dùng đến AI để xin sự hỗ trợ nhanh 
chóng và tiện dụng, chính xác lên đến hơn 90%. AI có thể 
đọc được 3 loại thông tin đầu vào: văn bản, hình ảnh, 
giọng đọc và cũng cho ra 2 loại thông tin đầu ra là văn 
bản và giọng đọc (hình 11). 

 
Hình 11. Hình ảnh màn hình giao tiếp giữa người dùng với chuyên viên 

dinh dưỡng 

Giai đoạn 5: Tự học và điều chỉnh qua thời gian 
(Adaptive Learning & Optimization) 

Hệ thống AI liên tục học từ dữ liệu mới thông qua cơ 
chế học tăng cường (Reinforcement Learning):  

- Đo lường hiệu quả thực đơn thông qua các chỉ số sức 
khỏe thay đổi và cảm nhận chủ quan người dùng. 

- Điều chỉnh thực đơn để tối ưu hóa các chỉ số như: 
mức năng lượng, cảm giác no, hiệu suất vận động, chỉ số 
đường huyết... 

- Ghi nhận các món ăn bị từ chối hoặc không phù hợp 
để loại bỏ khỏi danh sách gợi ý. 

Sau 1 - 2 tuần, hệ thống có thể tự điều chỉnh theo sở 
thích và hiệu quả thực tế, giúp AI "hiểu" người dùng ngày 
càng chính xác hơn. 

2.3. Thiết kế giao diện web và xây dựng mobile app 
trên Android Studio 

2.3.1. Thiết kế giao diện Web 

Giao diện người dùng của hệ thống chăm sóc dinh 
dưỡng chuyên sâu được phát triển nhằm đảm bảo tính 
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trực quan, dễ sử dụng và thân thiện với người dùng, đặc 
biệt là các đối tượng có kiến thức công nghệ hạn chế như 
người cao tuổi hoặc bệnh nhân mãn tính. Trang web 
được xây dựng với cấu trúc đa lớp, bao gồm: 

- Giao diện người dùng (Front-end): sử dụng HTML5, 
CSS3, JavaScript kết hợp với thư viện Bootstrap để tạo bố 
cục phản hồi (responsive layout) và tối ưu hiển thị trên 
nhiều thiết bị (hình 12). 

 
Hình 12. Hình ảnh giao diện khi mới bắt đầu trang web 

- Giao diện quản trị (Admin Panel): được thiết kế 
riêng dành cho chuyên viên tư vấn và quản lý hệ thống 
để theo dõi dữ liệu người dùng, xử lý các truy vấn tư vấn, 
điều chỉnh thực đơn và phân tích thông tin sức khỏe (hình 
13). 

 
Hình 13. Hình ảnh giao diện quản trị 

 
Hình 14. Giao diện hiển thị chỉ số BMI và BMR của cá nhân khi đăng nhập 

vào hệ thống 

Giao diện web gồm các chức năng chính: Đăng ký / 
đăng nhập tài khoản người dùng, nhập dữ liệu cá nhân 
(chiều cao, cân nặng, chỉ số sinh học…), hiển thị chỉ số sức 
khỏe (BMI, BMR, tỷ lệ cơ - mỡ…), xem thực đơn cá nhân 
hóa được đề xuất bởi AI, tư vấn trò chuyện với chuyên 
viên qua chatbot hoặc khung chat thật, xem công thức 
nấu ăn, mẹo dinh dưỡng, ưu lịch sử bữa ăn và theo dõi 
tiến trình cải thiện sức khỏe (hình 14).  

Hệ thống cơ sở dữ liệu MySQL được xây dựng để lưu 
trữ thông tin người dùng, thực đơn, lịch sử tương tác và 
dữ liệu sinh học. Giao thức API RESTful được triển khai để 
liên kết phần mềm web với mô hình AI (trí tuệ nhân tạo) 
và hệ thống tư vấn (hình 15). 

 
Hình 15. Bảng lưu trữ dữ liệu thông tin người dùng 

Đặc biệt, hệ thống có tích hợp OpenAI API (ChatGPT) 
để hỗ trợ trả lời nhanh các câu hỏi liên quan đến dinh 
dưỡng và sức khỏe, giúp người dùng nhận được thông tin 
tức thì và đáng tin cậy. 

2.3.2. Phát triển ứng dụng di động (Mobile App) 
Song song với giao diện web, nhóm nghiên cứu đã 

phát triển ứng dụng mobile app trên nền tảng Android 
Studio (hình 16), nhằm hỗ trợ người dùng có thể truy cập 
hệ thống mọi lúc mọi nơi qua thiết bị di động. 

    
Hình 16.  Hình ảnh giao diện phần đăng nhập 
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Ứng dụng được xây dựng bằng ngôn ngữ Java và 
XML, hoạt động trên hệ điều hành Android 8.0 trở lên, 
với các chức năng tương tự như bản web, bao gồm: Đăng 
nhập và đồng bộ hóa dữ liệu cá nhân với tài khoản web, 
nhận thông báo nhắc nhở ăn uống, uống nước, tập thể 
dục, truy cập nhanh thực đơn hằng ngày, khẩu phần dinh 
dưỡng theo AI, đo lường và theo dõi các chỉ số sức khỏe 
thông qua kết nối Bluetooth với phần cứng cảm biến (cân 
đo, nhịp tim… trò chuyện trực tuyến với chuyên viên qua 
nền tảng tích hợp như hình 17. 

 
Hình 17.  Giao diện chính của hệ thống 

Thiết kế giao diện theo chuẩn Material Design, đảm 
bảo tính hiện đại, mượt mà và dễ tương tác. Dữ liệu giữa 
ứng dụng mobile và server được đồng bộ thông qua 
Firebase hoặc API HTTP (Retrofit), đảm bảo cập nhật 
theo thời gian thực. 

Việc phát triển đồng thời cả web và mobile app (link:  
https://hethongchamsocsk.4devvn.com/)  không chỉ nâng 
cao khả năng tiếp cận của hệ thống tới nhiều nhóm người 
dùng khác nhau, mà còn góp phần hiện thực hóa mô hình 
chăm sóc sức khỏe đa nền tảng, giúp cá nhân hóa toàn 
diện quá trình tư vấn dinh dưỡng dựa trên dữ liệu liên tục 
được thu thập và phân tích. 

3. KẾT QUẢ THỰC NGHIỆM VÀ HƯỚNG PHÁT TRIỂN 

Hệ thống được triển khai thử nghiệm trong 12 tuần 
trên 150 người dùng tình nguyện, độ tuổi từ 18 đến 60, 
tại hai khu vực: thành thị (Hà Nội) và bán đô thị (Hưng 
Yên). Người tham gia được cung cấp thiết bị đo, tài khoản 
truy cập ứng dụng, và được hướng dẫn sử dụng hệ thống. 

Trong suốt quá trình, hệ thống thu thập dữ liệu chỉ số sinh 
học, hành vi ăn uống và phản hồi định kỳ qua bảng hỏi. 

Các chỉ số hệ thống đánh giá: 

- Độ chính xác phân loại thể trạng (so sánh với đánh 
giá của chuyên gia dinh dưỡng). 

- Mức độ hài lòng của người dùng (theo thang Likert 5 
mức). 

- Tỷ lệ tuân thủ khẩu phần (trước và sau 8 tuần sử dụng 
hệ thống). 

- Chỉ số sinh lý (BMI, huyết áp, vòng bụng) trước và sau 
can thiệp. 

Kết quả định lượng thu được sau 12 tuần thử nghiệm: 

- Độ chính xác phân loại thể trạng: 92%, kiểm định 
bằng confusion matrix với chuyên gia. 

- Mức độ hài lòng trung bình: 4,4/5; nhóm từ 25 - 45 
tuổi có mức hài lòng cao nhất (4,6). 

- Tỷ lệ tuân thủ khẩu phần: Tăng từ 51% lên 86% sau 8 
tuần (tăng 35%). 

- Chỉ số sinh lý: BMI trung bình giảm 1,3 (p < 0,01), 
vòng bụng giảm 2,4cm; huyết áp tâm thu giảm nhẹ ở 
nhóm béo phì. 

Phân tích paired sample t-test cho thấy sự cải thiện có 
ý nghĩa thống kê về BMI (p < 0,01) và tuân thủ khẩu phần 
(p < 0,005). Mức độ hài lòng có tương quan thuận trung 
bình với mức tuân thủ (r = 0,62), cho thấy trải nghiệm tích 
cực góp phần duy trì hành vi lành mạnh. Người dùng 
đánh giá cao tính linh hoạt và khả năng gợi ý món ăn phù 
hợp. Một số ý kiến đề xuất bổ sung kho thực đơn theo 
vùng miền, cải tiến nhận diện ảnh món ăn và cải thiện tốc 
độ phản hồi giao diện. Nhóm nghiên cứu ghi nhận các 
vấn đề về độ trễ dữ liệu cảm biến trong điều kiện sử dụng 
ngoài trời. Nhìn chung, kết quả cho thấy hệ thống có hiệu 
quả thực tế, phù hợp với hành vi người dùng Việt Nam, 
đồng thời cung cấp bằng chứng ban đầu về khả năng ứng 
dụng AI trong chăm sóc dinh dưỡng cộng đồng. 

Dù đạt được những kết quả khả quan, hệ thống vẫn 
tồn tại một số hạn chế cần khắc phục trong tương lai: 
Chất lượng và tính nhất quán của dữ liệu đầu vào: 
Một số người dùng nhập dữ liệu thủ công hoặc gửi ảnh 
món ăn thiếu ánh sáng, dẫn đến sai lệch khi phân tích 
bằng AI; Khả năng nhận diện thực phẩm bằng hình 
ảnh chưa ổn định: Thuật toán CNN dễ bị ảnh hưởng 
bởi ánh sáng môi trường, góc chụp, khiến việc phân 
tích thành phần dinh dưỡng không chính xác; Giới hạn 
về thiết bị cảm biến: Các cảm biến PPG và loadcell có 
sai số khi hoạt động trong môi trường thực tế (nhiệt độ 
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cao, rung động…); Thiếu đối chứng lâm sàng sâu: 
Nghiên cứu chưa bao gồm nhóm đối chứng độc lập, 
hạn chế khả năng khẳng định hiệu quả vượt trội của  
hệ thống. 

Từ kết quả đạt được với các tồn tại nhóm nghiên cứu 
cũng đã đưa ra hướng phát triển trong giai đoạn tiếp theo 
như sau: Chuẩn hóa dữ liệu đầu vào, xây dựng bộ công 
cụ nhập dữ liệu bán tự động (ví dụ: chatbot, nhận dạng 
giọng nói) và huấn luyện người dùng đầu kỳ; Tối ưu mô 
hình CNN, áp dụng các kỹ thuật tăng cường dữ liệu (data 
augmentation), sử dụng mô hình thị giác tiên tiến như 
EfficientNet, Vision Transformer để tăng độ chính xác 
nhận diện món ăn; Mở rộng tích hợp cảm biến y sinh, 
kết nối thêm cảm biến đo đường huyết, huyết áp, oxy 
máu nhằm mở rộng tính năng theo dõi sức khỏe toàn 
diện; Phát triển mô hình AI cá thể hóa sâu hơn, kết hợp 
dữ liệu gen, hồ sơ bệnh lý điện tử (EHR) và hành vi tiêu 
dùng để tăng mức độ cá nhân hóa; Tiến hành nghiên 
cứu lâm sàng có nhóm đối chứng, đảm bảo tính xác 
thực khoa học của các kết quả. Các hướng đi này nhằm 
hướng đến một hệ thống bác sĩ AI dinh dưỡng hoàn 
chỉnh, có thể áp dụng thực tiễn tại bệnh viện, trung tâm 
dinh dưỡng và cộng đồng. 

4. KẾT LUẬN  

Nội dung bài báo xây dựng mô hình hệ thống Bác sĩ AI 
hỗ trợ chăm sóc dinh dưỡng thông minh, tích hợp cảm 
biến sinh học, trí tuệ nhân tạo, học sâu và tư vấn trực 
tuyến. Hệ thống thu thập, phân tích dữ liệu sức khỏe cá 
nhân liên tục, đưa ra khuyến nghị dinh dưỡng cá nhân 
hóa, thích nghi theo thời gian thực và học từ phản hồi 
người dùng. Áp dụng nguyên lý human-in-the-loop, hệ 
thống đảm bảo độ tin cậy, linh hoạt trong tư vấn, hỗ trợ 
người dùng cải thiện sức khỏe chủ động, bền vững. Kết 
quả thử nghiệm trên 150 người dùng trong 3 tháng cho 
thấy độ chính xác phân loại thể trạng đạt 92%, mức hài 
lòng người dùng đạt 88%, chỉ số tuân thủ chế độ ăn tăng 
35% so với trước can thiệp. Kết quả này khẳng định tính 
khả thi và hiệu quả cao trong ứng dụng AI cho chăm sóc 
dinh dưỡng cá nhân hóa tại Việt Nam, với tiềm năng mở 
rộng áp dụng tại cơ sở y tế, trung tâm dinh dưỡng và cộng 
đồng. Tuy vẫn còn một số hạn chế như sai số dữ liệu đầu 
vào, giới hạn cảm biến và thiếu nhóm đối chứng lâm 
sàng, hệ thống đã chứng minh tính khả thi và tiềm năng 
ứng dụng rộng rãi. Trong tương lai, việc mở rộng mô hình 
AI cá thể hóa, tích hợp dữ liệu chuyên sâu và tiến hành 
nghiên cứu đối chứng sẽ giúp hoàn thiện và nâng cao 
hiệu quả của hệ thống trong chăm sóc sức khỏe cộng 
đồng và lâm sàng. 
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